
Microsoft Windows Tips 
 

These tips have been accumulated over the years for the SISD Announcements.  
They are in no particular order. 

 

Moving an Off-Screen Window 
Sometimes a window will get positioned off of your screen where you can't see the title bar. It is possible to 
move the window, and it's not that hard to do. Just open the program that is giving you the problem, and do 
the following: 
1. Press Alt + spacebar + M. 
2. Press the down arrow repeatedly until your title bar appears. 
Now you have full use of the title bar, and can minimize, maximize, and close your program more easily. 
Note that you can use this technique to move a window in ANY direction; just press Alt + spacebar + M and 
then press the appropriate arrow key. 
 
Windows Logo Key Shortcut Combinations 
Have you ever wondered what the Windows Logo key on your keyboard was for? Try the following 
shortcuts using that key. W stands for the Windows Logo key. 
W Open Start menu 
W + E Open Windows Explorer 
W + F Find a file or folder 
W + F1 Start Windows Help 
W + M Minimize all windows with minimize buttons 
SHIFT + W + M Maximize all windows that were minimized with the previous shortcut 
W + R Display the Run dialog box 
W + TAB Select open programs listed in the taskbar, in order. Press ENTER to activate the selected 
program. 
 
Maximize a Window Using the Title Bar 
If you ever have trouble clicking on the Maximize button, a quick way to maximize an application window is 
to double-click on the title bar. (Don't double-click on the buttons, though.) If the window is maximized and 
you double-click on the title bar, the window will be restored to its last size. This gives you the same result as 
using the Restore button in the title bar. 
 
Clearing the Documents List on the Start Button 
If you want to clear the contents of the Documents menu on the Start button, right click on the Taskbar, 
choose Properties, click on the Start Menu Programs tab and click the Clear button in the bottom half of the 
dialog box. If you want to be more selective in what you remove, go to the Windows/Recent folder in your 
Windows Explorer where you will find the shortcuts to all those items in the Documents menu. Just delete 
the ones you want for a more streamlined Documents menu. In Windows98 you can right-click on the files in 
the Documents list that you want to remove and choose Delete. 
 
Manipulating Multiple Programs From the Taskbar 
If you want to select multiple programs on the Taskbar (to close them all at once, maximize them, etc.), press 
CTRL while you left-click each button. When you've finished, right-click on one of your Taskbar selections 
and select your action (it'll happen to every chosen program). NOTE: you can reverse an accidental selection 
by clicking on a selected item. 
 
Copy a 3 1/2 Floppy Disk 
Take the disk you want to make a copy of, place it in your A: drive, and double click on "My Computer". A 
window will appear showing all the drives on your computer. Right click on "31/2 Floppy {A:}" and from 
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the menu that appears, click on "Copy Disk..." You will now be looking at the "Copy Disk" window. Make 
sure the "Copy from" and "Copy to" boxes both say "3 1/2 Floppy {A:}" and click the button that says 
"Start". The window will show you the progress as it reads your disk, and when the bar gets halfway across, 
you will be asked to insert the disk you want to copy to, into your A: drive and click "OK". When the 
contents of your disk have been successfully copied, you can remove the new disk, and close the Copy Disk 
window. Since the data on floppy disks can easily become corrupted, it is a good idea to have backup copies 
of your data and programs that are stored on this medium. 
 
Restoring and Maximizing Windows with the Keyboard 
Follow these steps to make a window switch back and forth between full screen and reduced size: 
1. Press Alt+Spacebar to display the Control menu. 
2. Press the letter R; the window is restored to its reduced size. 
3. Press Alt+Spacebar to again display the Control menu. 
4. Press the letter X; the window is maximized. 
Do steps 3 and 4 first if the window is already reduced. 
 
Finding Desktop Icons 
It's sometimes hard to find an icon on a Desktop that's cluttered with dozens of them. Here's a quick way to 
locate the one you're looking for. All you need to know is the name under the icon. Click anywhere on the 
Windows desktop and press the first letter of the icon's label. Windows will highlight the first icon it comes 
to beginning with that letter. If that's not the one you're looking for, keep pressing the letter and watch the 
highlight as it cycles through the matching icons. 
 
See Two Programs at the Same Time 
Close all programs and open only the two programs you want to see. Then, right-click on a gray area of your 
taskbar and select either 'Tile Windows Horizontally' or 'Tile Windows Vertically' from the menu. You will 
then see both programs at the same time. When you're finished working with those programs, you can right-
click on your taskbar again and select 'Undo Tile'. 
 
Previewing Files in Windows Explorer (98) 
You can view files in Windows Explorer windows with these options: Web Page, Large Icons, Small Icons, 
List, or Details. While the Web Page view is great for previewing documents one at a time, there's a way to 
preview everything at once. Right-click on a folder and select 'Properties'. At the bottom of the dialog box 
you should see the option to 'Enable thumbnail view.' Place a checkmark in that box. The next time you're in 
that folder and you change its view, you'll see the 'Thumbnail' option. All graphics, Web pages, and 
(possibly) documents will be previewed directly within that Explorer window. 
 
Windows 98 Sliding Menus 
Windows 98's default way of sliding out menus and windows usually distracts some people. To make menus 
pop out, as they do under Windows 95, right-click on your desktop and choose Properties. Click on the 
Effects tab and under Visual Effects, click to remove the checkmark next to Animate windows, menus, and 
lists. If you change your mind later, you can return here and click to put a checkmark back into the box. 
 
Copy Files to a Floppy Disk 
The easiest way to copy your files to a floppy disk is to find your files in Windows Explorer, right click on 
each file, move your cursor over "Send To" and then from the list of places you can send the file to, click on 
your floppy drive. You can copy any file this way, as long as it will fit on the floppy. 
 
Fast Route to System Properties 
Instead of clicking your way through the My Computer icon to get to System Properties, an easier way is to 
press the Windows key + Pause. 
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Screen Capture 
To create a full-screen capture, first press the Print Screen key. That action sends a copy of the screen to the 
Clipboard. To view the capture, open Word and paste the image from the Clipboard into the Word document. 
It will then become a graphic that you can crop, size, copy and paste into another program. You can also 
open Paint in your accessories list, select Edit/Paste to paste the image from the Clipboard into the Paint 
window and then choose File/Save As to name and save it as a BMP file. To create a capture of an open 
Window instead of the full screen, press Alt + Print Screen and follow the above directions. 
 
Don't Work Off of Floppies 
Some people have a tendency to store their data files, including Word documents, on floppy disks and work 
from the floppy. They think this is safer, in case the hard disk has a problem. This may have been true in the 
early days of hard disks, but there are a number of reasons not to use floppy disks to store your documents: 
 
It is much slower loading and saving documents. 
Floppy disks are more prone to disk errors than hard disks. 
It is too easy to misplace a floppy disk. 
If the size of your document becomes larger than the available space on your floppy, you may lose the entire 
file. 
 
In addition, it is not unusual for new users to remove the floppy disk from the disk drive before they are done 
editing the file on Word, or before Word has completed saving the file to disk. If you do this, you run the risk 
of corrupting the file and losing it. It is better to save your files to your hard drive and use your floppies for 
backups. 
 
Right-Click with the Keyboard 
Tired of having to reach for your mouse? You can do just about anything without it-even "click" something 
with the right-mouse button. The next time you need to right-click the desktop, an active window, or 
anything highlighted, press Shift-F10 instead. Then press the underlined letter of the menu selection you 
want to choose. 
 
Printing From the Desktop 
If you need to print a file that's on your desktop or in Windows Explorer, don't waste time opening the file 
and selecting the application's Print command. Windows 98 will let you right-click the file you want to print 
and select Print in the pop-up menu. If you don't see the Print command, you can't print the file this way. 
Certain file types don't support this feature. 
 
Bypass the Recycle Bin 
In a previous tip, you learned that you could bypass the Trash folder in Netscape E-mail by pressing the Shift 
key as you press Delete on the keyboard. If you're sure you want to delete something the first time around, 
you can also skip right over the Recycle Bin the same way. Just select whatever it is you want to get rid of, 
press Shift-Delete, and it will be removed. You'll still get one of those polite messages asking if you're sure, 
but remember there is no second chance when you delete this way. 
 
More Keyboard Shortcuts 
When working with text, it is more efficient to use keyboard shorcuts instead of the mouse. There are many 
shortcuts to learn. These are a few good ones to add to your list: 
Ctrl + Backspace will delete entire words 
Ctrl + Home will take you to the top of the document 
Ctrl + Shift + Home will select all the data between the cursor and the top of the document 
Ctrl + End will take you to the end of the document 
Ctrl + Left Arrow will move you one word back 
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Ctrl + Right Arrow will move you one word forward 
Shift + Home will select all of the text in a line from the cursor to the left 
 
View Windows Explorer Full Screen 
Use the F11 Key to switch back and forth quickly between the Maximized (Full-Screen) and Restored 
(Windowed) Explorer windows. 
 
Record Time and Date in Notepad 
You can use your Notepad accessory to keep a record of events. To insert the current time and date in a 
Notepad file, press F5. Or, if you want to log the date and time automatically each time you open a Notepad 
file, type .LOG (must be in all caps) on the first line, then save and close the file. Every time you open the 
file thereafter to add new information, the current date and time will be recorded. 
 
Close Down Shortcuts 
The quick way to close a Windows program is to press Alt-F4. In programs like Microsoft Word that can 
have several documents open at a time, press Ctrl-F4 to close the current document. To close Windows itself, 
press Alt-F4 while the desktop is selected and the Shut Down Windows dialog will be displayed - much 
easier than clicking on Shut Down in the Start menu. 
 
Enlarging Your Scrollbars 
Do you find the scrollbars in your applications and dialog boxes too small to grab onto? Windows lets you 
make them as big (or as small) as you want. Right-click the desktop, select Properties, and click the 
Appearance tab. Under Item, select Scrollbar, adjust the Size using the up arrow, and watch your change in 
the preview window. When you like what you see, click OK to keep the change. 
 
Viewing Folders in Windows Explorer 
When you view a folder's contents in Details view (select View, Details), some columns of information are 
probably cut off. (Each cut-off entry is followed by ellipses.) One way to view the hidden information is to 
resize each column. Or, try this trick: Hold down the Ctrl key as you press the plus sign (+) on your numeric 
keypad. Instantly, Windows sizes every column to fit the widest entry. (Note: In many cases, you'll need to 
enlarge the window to see every column of information.) Pressing Ctrl + also shrinks oversized columns to 
fit the widest entry. 

Using the Send To Feature 
When you use Window's Send To feature (right-click on the file, then select Send To from the Context 
menu) to place something on a floppy disk or on a drive other than your C: drive, the file is copied. To move 
it, hold down the Shift key while clicking on the Send To item. 
 
Quick Launch Bar (Windows 98) 
Windows 98 provides a Quick Launch section in the taskbar that is more efficient (with just one click and no 
need to minimize) than having the shortcut icon displayed on your desktop. Create shortcuts on your desktop 
to your favorite programs and then drag those shortcut icons from your desktop to the Quick Launch area. 
Delete any you no longer wish to keep by right clicking and selecting Delete. 
 
Viewing the Cipboard 
If you forget what you last left on your Clipboard, you can get a quick look at it without doing any pasting. 
Simply go to Start, Programs, Accessories, System Tools, Clipboard Viewer. Doing this saves you from 
messing up your work by pasting an unwanted chunk of data into an existing file. 
 
Quick View 
Quick View is an underused, under-appreciated feature of Windows. It lets you quickly and safely see the 
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contents of documents without opening their associated applications. Just right-click on a file in Windows 
Explorer and choose Quick View. 
 
Hard Drive Space 
Wonder how much free disk space you have? In Win98, open My Computer and select the "View as Web 
page" option under the View menu. Click on your hard drive, and the status of the drive (including total 
capacity, free space and used space) will be displayed on the left side of the screen. 
 
Cleaning Your Mouse 
If your mouse acts up, it probably needs a good cleaning. As you move your mouse around, the ball picks up 
all sorts of dust particles, hair, etc. These particles collect on the internal rollers which the ball comes into 
contact with. If you get too many of these particles in there, the mouse just starts acting funny. This is what 
you need to clean it: 
 
- A couple of Q-tips 
- Isopropyl alcohol 
- Something sharp and pointed (tweezers work well) 
 
First, disconnect your mouse, and turn it over. Around the ball will either be a rotating ring or a ring that 
slides back. Whichever you have, open the ring and take the ball out. Look inside and you will see two or 
three roller bars. These bars are what the ball moves to translate the motion into electrical signals. If your 
mouse is really dirty, you'll notice hunks of dirt around the center of these bars. Wet the tip of one of the Q-
tips in alcohol and soak the rollers. Don't overdo it, but try to get enough on them to loosen the dirt. Next, 
take your tweezers and lightly scrape and pick off the dirt. 
 
If your roller bars are plastic, be careful not to gouge them or your mouse will do permanent damage. Also, 
try not to let the scraped off dirt fall into a hard to reach area inside of the mouse. After getting the big stuff 
off, go back in with the alcohol soaked Q-tip and rub the roller bars. There is no problem with rotating the 
bars to clean all around them. Before putting the lid back on the mouse, clean it with the alcohol. Once this 
has been completed, plug the mouse back in and you should have a smooth-rolling mouse again. 
 
The Calculator's Memory Function 
Suppose you've just completed a calculation (in the Windows 98 Calculator), and you'd like to insert the 
result into another calculation. Don't waste time writing it down. Store it in memory so you can insert it into 
the next equation at the click of a button. With the number you'd like to store in memory displayed in 
Calculator, click the MS button. (An "M" appears in the gray box above all the "M" buttons.) Now go ahead 
with the other calculation. When you need to insert the stored number, click the MR button. 
 
Copy to Floppy Disk 
One way to save an e-mail attachment is to Drag and Drop: 
1. Left Click on the attachment and drag it to the desktop and release. (You'll need to Restore your windows 
so you can see the desktop.) 
2. You can Right Click and drag it to the desktop but then you must choose what to do with it ("Move Here" 
or "Copy Here") 
 
To Copy or Move to a Floppy: 
1. Open My Computer and Right Click on your Floppy Drive. 
2. Select Make a Shortcut. (Windows will make a shortcut on your Desktop as soon as you Click OK) 
3. Any time you want to save "anything" to a floppy disk, just drag it and drop it onto the Floppy Icon. 
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Scientific Calculator 
There is an easy way to transform a seemingly simple Calculator into a scientific tool: Select Start, Programs, 
Accessories, Calculator; then select View, Scientific. Not sure what each of these new buttons does? All you 
have to do is ask. Right-click any button and click What's This? to display a description of that button with a 
keyboard equivalent at the bottom. 
 
If you want to print a list of these shortcuts, from the calculator window, select Help, Help Topics. On the 
Contents tab, select Tips And Tricks, then select Use Keyboard Equivalents Of Calculator Buttons. Inside the 
Calculator Help window, select Options, Print, Print The Selected Topic, and then click OK. Adjust any 
printer options, if necessary, then click OK one more time. 
 
Minimize Windows Using the Keyboard 
If you've every accidentally clicked the "X" on a window when you meant to click the minimize button, then 
you may like this tip. Press Alt-Spacebar, then press N to send active windows to the Taskbar. 
 
Inserting Clip Art on Windows 2000 Machines 
(This will only work on new Windows 2000 machines with Office 2000 installed) 
 
Many of you have found that you cannot access much of the clip art in the Microsoft programs. You can now 
access all of the clip art available to you by following these steps. First, open any Microsoft Office 2000 
program that uses clip art and then: 
 
1. Choose Insert on the Menu Bar, then Picture, then Clip Art 
2. Select the picture Category that you wish to use. 
3. Choose your picture by clicking on it. 
4. Click the 1st option in the pop up box: "Insert Clip" 
5. Choose "Look Elsewhere" 
6. Click Update Location. 
7. Click the down arrow at the right of the Look In: bar. 
8. Choose: "clipart on central..." 
9. You will see a flashlight searching; Click OK. 
10. Your piece of clipart is inserted. 
 
You will only have to do this once. After the initial picture insert, you may click on any picture in the 
catalog, choose Insert Clip, and it will be inserted without having to go through steps 5-9. 
 
Open Text Files in WordPad Instead of Notepad 
Here's an easy way to always open .txt files in WordPad rather than Notepad. Click once on any .txt file, then 
hold down the Shift key and right-click on the file. Choose Open With from the pop-up menu, scroll through 
the list of programs and choose WordPad. Check the box labeled "Always use this program to open this type 
of file" before you click on OK. 
 
Adding a Scrap to the Desktop 
In Microsoft office programs, you can keep the contents of the clipboard on your desktop for later reference 
by creating what is called a scrap. You can recognize a scrap by its icon: It looks like a document file except 
for a torn edge along the bottom. If you have material copied to the clipboard, you can right-click on the 
desktop and select Paste to create a scrap containing the clipboard information. When you double-click the 
scrap, it will open in the program in which it was created. 
 
Using the Character Map 
While word processing programs have their own procedures for accessing special characters, in Windows 98 
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you can retrieve characters for use in any program by using the Character Map utility. This little program 
allows you to copy characters to the clipboard for insertion into any document. Access the Character Map by 
going to Start, Programs, Accessories, System Tools, Character Map. You can browse the various fonts using 
the drop-down menu at the top of the dialog box. When you find a character you want to copy, select it with 
the mouse, then click the Select button and the Copy button to copy it to the clipboard. (You can even select 
a sequence of characters, if you like, before you click Copy.) Then click Close, return to the program you 
were working in previously, and press Ctrl-V to paste the character (or sequence of characters) into your 
work. 

Selecting Files in Windows Explorer 
In Windows Explorer you want to select a bunch of files leaving out only a few. Press Ctrl and click on the 
ones you don't want, then click Edit, Invert Selection. 

Moving or Deleting Desktop Icons 
You can select groups of icons or folders on the desktop or within folders by clicking outside the body of 
icons and, while holding the left mouse button, dragging a rectangle to surround all of the icons you want to 
select, then letting go. You can then move, copy or delete them all at once. 

Protecting Floppy Disks 
If you have a floppy disk with information that you don't want to overwrite or delete, there is a way to protect 
it. Floppies can be write protected by sliding a little tab so that it exposes a small hole in the upper right-hand 
corner of the disk (the slider is on the back side of the disk). If the hole is open, the disk can't be written to. If 
the hole is closed, it can. Just slide the tab to your preference. Some disks, especially the kind you get from a 
software company, may be read-only. 

Keyboard Shortcuts 
(Some of these may have been in previous tips, but for those who prefer to use the keyboard as much as 
possible, they are worth repeating.) 
 
Shift-F10-----------------Right-click selected item 
Ctrl-Esc------------------Display Start menu 
Alt-[underlined letter]-----Select menu command 
Alt-Esc-------------------Switch to Taskbar's "next" open window 
Alt-Tab-------------------Switch among open windows (hold Alt and continue to press Tab) 
Alt-F4--------------------Close active window 
Alt-Spacebar-N----------Minimize active window 
Alt-Spacebar-X----------Maximize active window 
Alt-Spacebar-R----------Restore active window 
Alt-Spacebar-C----------Close active window 
Ctrl-F10------------------Switch focus to menu commands (in any Explorer window) 
Ctrl-Tab------------------Rotate through dialog box tabs 
Ctrl-Shift-Tab-------------Rotate through dialog box tabs in reverse 
Ctrl-Alt-Del---------------Display Close Program dialog box 

A Renaming Shortcut 
There are two common methods for renaming files and folders. You can right-click on the object and select 
Rename, or you can click once on the name itself, wait for the insertion point, and start typing. There is 
another way to rename files and folders: Just select the item, press F2, and begin typing. 
 
Drag and Drop With the Right Mouse Button 
You've probably noticed that dragging and dropping objects in Windows 98 does different things at different 
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times. If you drag a program, Windows assumes you want to create a shortcut. If you drag a file, Windows 
assumes you want to move it. And if you drag an object from one drive to another, Windows assumes you 
want to copy it. If you want to specify the kind of drag-and-drop operation you want to perform from the 
outset, try dragging and dropping while holding down the right mouse button. You're then given the choices 
of Move Here, Copy Here, or Create Shortcut Here. Just select one of the three, or choose Cancel to abort the 
operation. 

Viewing the Date in the System Tray 
You probably already know that you can see the date at any time by double-clicking on the clock in your 
Windows system tray. But if you're in a hurry, you don't have to click at all. Just position your cursor over 
the clock and the full date pops up. 
 
Make Quick Launch Buttons Larger (98) 
If you have trouble seeing the Quick Launch buttons on your Taskbar, Right-click a blank space on the 
Quick Launch toolbar, select View, and then select Large. 
 
Add Gradient Color to Title Bar 
Everyone gets bored with the look of his or her desktop eventually. One way to give your title bar an 
interesting look is to assign it two colors. Windows automatically creates a nice gradient along the top of all 
your windows. To try using two colors for your title bars, just right-click on your desktop and select 
Properties. Click the Appearance tab and under Item select Active Title Bar. Normally, both Color and Color 
2 are the same. Choose a different color for Color 2, and your title bars will have a nice looking gradient. 

Open My Computer in Dual-Pane Mode 
If you want to browse your computer in dual-pane mode (the typical view for Windows Explorer), you can 
do this quickly. Just hold down the Shift key while double-clicking the My Computer icon. 

Switch Between Open Windows 
Hold down your ALT key and press your tab key. A small screen will pop up displaying the icons of the 
currently open programs. Keep clicking the tab key (while holding down the ALT key) until you land on the 
window you wish to see. 
 
Folder Shortcuts 
In Windows Explorer, find the folder you want to create a shortcut to, then right click on the folder. Choose 
Send To in the context menu, then Desktop (create shortcut). A shortcut to the folder is automatically created 
on the desktop for you. 
 
Using the Center Mouse Wheel 
If your mouse has a center wheel, go to any web page and point your arrow at a blank spot on the page. 
Rotate the center wheel to scroll up and down the page. This also works in other programs that may require 
scrolling. 

Retrieving a Deleted File 
Did you just delete a file but now you think-ooopps, I need it back. Hold down the Ctrl button and hit the Z 
key and it will reappear. Keep in mind, this will ONLY work if you do it immediately after deleting the file. 

Tabbing Through Folder Tabs  
To move through the tabs at the top of a dialog box without using the mouse, all you need to do is press Ctrl-
Tab. To move backward through the tabs, press Ctrl-Shift-Tab.  
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Clearing the Way for a Drag-and-Drop 
Have you ever grabbed something and started dragging it only to find that your destination was obscured by 
an open window? Here's a little trick that will help in these situations. Continue to hold the item you're 
dragging, and move it over your system tray. Keep it still for a second or two, and every open window 
automatically minimizes, leaving you an open desktop. 

Shortcut to Floppy Drive 
An easy way to view the contents of a floppy disk is to double-click a floppy drive shortcut on your desktop. 
Open a My Computer or Explorer window, click and drag your floppy drive icon out to the desktop and 
release the mouse button. Click Yes to confirm that you want to create a shortcut. The next time you want to 
view the contents of a floppy, insert it in the drive and double-click your new shortcut. 

Increasing or Decreasing Display Font Size with the Mouse 
If you have a scrolling mouse (a little wheel between the two buttons) you can change the size of the display 
font simply by holding down the [Control] key while moving the mouse-wheel. The font size changes either 
up or down based on the amount you move the mouse-wheel. This doesn't actually change the size of the 
font, just the way you are viewing it. It works in most programs that have text. 

Refresh Your Floppy 
Have you ever been looking for something on a floppy disk? You stick the first disk in, click the icon for 
your A: drive, discover it's not what you were looking for, then you stick the second one in, go back to the 
drive A: icon, click it again, and so forth. Each time you insert a new disk, you have to click the A: drive to 
get the computer to update what's on the disk. An easier way is to press the F5 key when you swap disks. It 
will refresh the contents without having to go back to your A: drive every time. 

Quick Backup  
To make a quick backup of a file, first select the file in the Open dialog box or in Windows Explorer. Then 
press Ctrl-C and then Ctrl-V. This will, in the same folder, create a copy of the file with the prefix "Copy 
Of."  

Create Folders in the Save and Open Dialog Boxes  
After you Open (Ctrl+O) or Save (Ctrl+S), click the Create New Folder icon (the folder with the starburst) or 
press Alt+5. Type a folder name. Press Enter. It will automatically open the new folder. If you are in the 
Save window, click Save to save your document in the new folder.  

Window Off the Screen 
If you want to open any window control menu, you can either right-click at the very top of the window where 
the window's title is located, or you can hold down the Alt key and press the space bar. This comes in handy 
if the window title bar is not showing. 

Quickly Show Desktop 
Q: How do you minimize all windows at once and show the Desktop? 
A. Press the Windows Key + M 
B. Click the Show Desktop button on the Quick Launch toolbar. 

Important File On Disk  
Do you have an important file in a crowded folder that you would like to access quickly without having to 
scroll past the other files? It's easy to set this up. While in Explorer, rename the file so that the first character 
is an underscore _. 
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Imaging Program 
Windows comes with a utility in the Accessories menu called Imaging. Imaging can be used to open just 
about any kind of image file. To start the imaging program, go to Programs, Accessories and click on 
Imaging in the menu list. After opening your image file, there are options for viewing and printing. 

Screen Saver Banner 
The Flying Objects screen saver will let you turn any bitmapped (.bmp) picture into a flying banner. Right-
click on your Desktop and select Properties, click the Screen Saver tab and select 3D Flying Objects from the 
menu. Click on the Settings button to the right. Click the down arrow to the right of the Style option and 
choose Textured Flag from the list. Then click the Texture button and locate and select any .bmp image. 
Click the Open button. Put a checkmark in the Smooth Shading box and set the Resolution and Size controls 
to Max. Click OK and then the Preview button to test it.  

Creative Desktop Wallpaper  
Let your students take turns creating desktop wallpaper for your classroom computers. Go to Start, Programs, 
Accessories and open Paint. Students can create pictures using the Paint tools. When they are finished, Save 
each picture and then choose File, Set as Wallpaper. The pictures can be Centered or Tiled. If you right-click 
on the desktop and choose properties, you can choose Stretch in the Display drop down menu which will 
make the picture stretch to fit the desktop. 

Make Your Folder an Instant Tool Bar  
If you want to create a tool bar for a folder on your destop, grab the folder and drag it to the edge of the 
screen-either left, right, top, or to the current toolbar menu at the bottom of the screen. An instant tool bar 
will appear showing all the contents in that specific folder. You can do the same thing from Windows 
Explorer by dragging the folder to the edge where you want the tool bar to appear. 

Volume Control 
If you single-click on the Volume icon in the tray area (lower right corner of taskbar), a small box appears 
with a slider control and a mute box for volume. From here you can control the volume coming from the PC 
speakers. 

Detail View in Windows Explorer 
If you find yourself scrolling left and right, up and down while in Explorer looking at icons, change the View 
to "Details" and this will make the list scroll only up and down. Also, the icons will be much smaller. This 
helps save some time. 

Sorting In Windows Explorer 
If while in Explorer you click on a column heading such as Name or Date Modified, the order of the 
displayed files and folders will be prioritized based on ascending or descending sequence of the column 
heading you just clicked. If you click the same column heading again, the order will be reversed. This 
sorting only applies while in the Details view. 

Insert Accents or Special Characters with Codes 
Click where you want to insert the accent or character. Make sure the NUM LOCK is on. Hold down the 
ALT key, and then, using the numeric keypad, type the character code. Here are some commonly used codes: 
129 - ü 
130 - é 
133 - à  
138 - è 
148 - ö 
155 - ¢ 
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160 - á 
164 - ñ 
171 - ½ 

Click and Drag 
If, while dragging a file, you decide you no longer want to do what you intended, press the Esc key without 
releasing the mouse button and the dragging will cease. This works in all programs in which dragging files or 
objects is an option.  

Being Productive with the Your Start Button 
You can open several different programs or files through your Start button without having to return back to it 
to relaunch. Hold the Shift key down and then click the Start button. Click on the programs you wish to open. 
Windows will launch each program you click on but retain the focus on your Start menu, offering you the 
ability to launch additional programs. As soon as you let go of the Shift key, the Start button/menu will 
minimize. You may not see your launched programs on the screen, but they should appear on your task bar.  

Maximize, Minimize and Close All Windows 
You have several applications that you want to close. Hold down the Ctrl key and click on each one of the 
applications you want to close on the taskbar. Right-click one of the applications. There will be a context 
menu for you to Close, Minimize, or Maximize. Select one action and all the applications you selected will 
close, minimize or maximize at the same time. 
 
Control Key for Copying 
To copy a file without having to perform any additional work, press and hold the Ctrl key while dragging the 
object to its destination. Windows will automatically make a copy of the file. 

Open A Web Page From The Start Menu 
If you prefer, you can open a web page from the Windows Start menu. Let's say that you want to do a search 
on Google while you're working with your word processor. All you have to do is click Start, Run, type in 
www.google.com and press Enter. Your default browser will open at the Google Web site.  

Reading the Name of a Program on the Taskbar 
Sometimes, the name of a program running in Windows is longer than the taskbar's button. If you hold your 
mouse cursor over the button for a few seconds, the entire name will be displayed. Also, if you have a file 
open in some tasks, the filename currently being reviewed is usually also displayed. 

Standard Help 
In most Windows applications and software, help is quickly and easily available by pressing the F1 button. 
Immediately, pop-up windows or the Paper Clip will show up with message boxes and search indexes ready 
to assist you with your problem. 

Right-click Shortcut 
You can open the right-click menu with shortcut keys. Make sure what you want to right-click on is selected 
and press Shift + F10 to open the menu.  

Print Selection 
If you want to print only a couple of lines from something (a document, email, worksheet, etc…) Select the 
information to be printed. Then go to File, Print or (Ctrl+P). In the Print window under the Page Range 
section, choose Selection. Then press OK or Print. 
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Keyboard Shortcut to Place a Check Mark in a Box 
To place a check mark in a box, or select an option in a window, press the space bar. Just use the tab key, or 
arrow keys to get to the option, then press the spacebar to select it. 
 
Finding Out How Much Hard Drive Space You Have Left 
To see how much space you have left, open the My Computer icon on your desktop and right-click on the 
drive you are curious about (for most people, this would be their C: drive, but this works with any drive). 
Select Properties from the resulting menu. You'll get a pie chart showing you how much disk space is left. 
 
Mouse-less Program Switching 
To switch between open programs, hold down the Alt key and press Tab. A little window will pop open in 
the center of your screen. In it there is a row of icons for the programs you currently have open. One of the 
icons should be boxed in. When you release the keys that will be the program you'll be taken to. To move the 
box from program to program, press the Tab key while still holding down the Alt key. This will toggle 
through all open programs. Press the Tab key enough times to get to the program you wish to go to and then 
release all keys. 
 
Jump Between Open Files 
To jump between multiple open files in a program, press the F6 key while holding down the Ctrl key. What 
this will do is toggle between all open files in the program. While holding down the Ctrl key, you can 
continue to press the F6 key until you rotate to the file you need. 

Selecting Tabs in Dialog Boxes 
Many of the dialog boxes used in Word (and other Windows programs) utilize the concept of tabs. These 
look like index cards within the dialog box, and are used to organize information. A good example of a Word 
dialog box that uses tabs is when you choose Options from the Tools menu. If you want to move from one 
tab to another, the usual way of doing this is by using the mouse. You can, instead, use the keyboard. To 
move forward through the available tabs, press CTRL+TAB. To move backwards, use SHIFT+CTRL+TAB.  
 
Quickly Close Several Open Programs 
The fastest way to close multiple programs is to hold down the Ctrl key as you click their buttons on the 
taskbar. Then, right-click (still holding down the Ctrl key) one of those depressed buttons and select Close 
from the resulting menu. You can also minimize, maximize, restore, cascade, or tile these windows using the 
same technique.  

Quickly Access the Save As Dialog Box 
If you haven't yet saved a new document, the Save As dialog box automatically appears when you click the 
Save button. However, once you've saved your new document, clicking the Save button no longer opens the 
Save As dialog box; instead, it simply saves your document in its current location using its current filename. 
If you want to access the Save As dialog box to save your document in a different location or to a different 
filename, you probably know that you can choose File, Save As from the menu bar. However, if you want to 
spare yourself a few mouse clicks, try using the [F12] shortcut key instead. 

Right-click Using Your Keyboard 
Three keys to the right of your space bar is a key that looks like a menu with an arrow pointing to it. Space 
Bar, Alt Key, Windows Key and then the Menu Key. If you press the Menu Key, it will bring up the menu 
you normally bring up when you right-click. From there you can use the arrow keys to navigate through the 
pop-up menu and the Enter key to select your choice. To get out of the pop-up menu, press the Esc key. 
 
Maximize and Minimize Windows Quickly 
To maximize or minimize the size of any window, double-click the title bar. 
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Closing Programs Shortcut 
To close the program you are working in without touching the mouse, the keyboard combination Alt + F4 
will close your application and Ctrl + F4 will close your current file. This also works great for closing pop up 
Internet windows. 

Correcting Mistakes 
First, if you make a mistake, press Ctrl+Z. In most programs, that will undo whatever it was that you just did. 
The bad thing is that many programs only give you one or two of these "undo's." One way to make sure you 
can always go back is to save your file frequently - especially if you're about to make some big changes. 
Then if you really mess up, just close the file and DON'T SAVE IT. When you open it back up, it will be 
back to the way it was when you last saved.   

Inverse Selections 
Sometimes you may need to select most of the files in a folder while using Windows Explorer. Maybe you're 
copying them to a floppy or moving them. First, select the files you DON'T want. If there are multiple files 
that you don't want, hold down your Ctrl key as you select the files. Next, go to the Edit menu and select 
"Invert Selection" from the menu. The files you selected previously are now deselected and everything else is 
selected. Another way to do it is to go into the folder with the files you want, press Ctrl+A (to select all). 
Next, hold down your Ctrl key and click the files you don't want. That will leave the ones you want to copy, 
move or delete. This last part will also work in e-mail lists. 

Keyboard Shortcut to Rename Files 
If you want to rename a file, select it and press F2 on your keyboard. This works on Desktop icons, in 
Windows Explorer, in the Open dialog box, in the Save As dialog box, etc.   

Sorting Files in the Open Dialog Box 
Sometimes you might want to sort files by the date and time they were modified. To do this, choose File, 
Open. When the Open dialog box appears, click the down arrow next to the Views button and choose Details. 
Then click on the header for the column you would like to sort by. In this case, it would be the Modified 
column.  

Desktop Auto Arrange Option 
How do you keep desktop icons from jumping back into neat little rows every time you try to move them? 
By default, Microsoft made the Auto Arrange option the default. If you want free-flowing icons, you'll need 
to turn this option off. Right-click the desktop and select Arrange Icons. In the resulting menu, you'll see a 
check mark next to Auto Arrange. Select this option (to deselect it). Now you will be able to relocate your 
icons. If your icons are all over the place, choose Auto Arrange to put them in order. 

Lasso Desktop Icons 
You can make multiple selections by "lassoing" icons on your desktop. Drag a box around several icons. 
Press the Enter key and you'll launch all of the lassoed programs at once. This also works in both My 
Computer and Explorer for lassoing files. It's useful if you need to open or delete multiple files. Make sure 
you lasso OUTSIDE of the icons. It doesn't work if your mouse click starts ON the icon. 

Alternative to Right-Clicking  
Clicking with the right mouse button brings up menus with choices appropriate to the item you clicked. You 
can also open these menus by pressing Shift + the F10 key. Once the menu appears, select the underlined 
letter from any of the menu items to launch that command. You may find using keyboard commands in this 
way helpful when your mouse isn't working. 
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Protecting a Document From Being Changed  
If you have documents that you want to protect from changes, follow these steps: 
1. Right-click the icon of the file you wish to protect. 
2. Choose Properties from the menu that appears.  
3. Click next to the Read Only check box to protect it from changes.  
To Remove the Read Only attribute from the protected file so you can make changes, follow the same steps 
and remove the check mark. 

Close It In A Hurry 
Here's another trick for using one of the function keys that works in most programs. 
Ctrl + F4 will close the file.  
Alt + F4 will close the program.  

Renaming a Desktop Shortcut 
To rename a desktop shortcut, right-click the shortcut and select Rename from the resulting menu. The 
shortcut's name will now be selected. Just type in the new name and press Enter. You can also single-click 
the icon and press the F2 key. This will select name and allow you to type in the new name. 
 
Quickly Changing Windows 
If you use several open Excel workbooks or Word files to do your work, you probably already know that you 
can change between workbook or file windows by choosing the file name from the Window menu. You may 
not know, however, that there is a shortcut for changing windows. You can cycle through your documents by 
pressing either Ctrl+F6 or Shift+Ctrl+F6. Ctrl+F6 cycles through the list of windows in a forward direction, 
while Shift+Ctrl+F6 cycles in reverse. 

Renaming a File 
There are at least three ways to rename a file: 
1. Click the file name once to select, click a second time to make it available to change, then type in the new 
file name. 
2. Right click the file and choose Rename. This will select the file name allowing you to type in a new one. 
3. Hold down the Alt key and double click the file to open the Properties box. Type the new name in the 
name box. 
 
Alphabetize Programs 
If you would like to list all of the program groups under the Start button, Programs menu alphabetically, 
Click the Start button and select Programs. Select any program group (menu item) that's listed there. Then, 
right-click and select "Sort by name" from the resulting menu. You can still drag and drop program groups 
around if you want to manually specify which ones sit at the top of the list. 

Quick Print Documents 
If you have My Documents open and wish to print one of your files, you can print without opening the 
document. Just right-click on the file and choose Print. This will automatically open the document, send it to 
the printer and then close the file. 

Using the Character Map 
If you need a symbol or some other special character like the degree symbol, the small square checkbox, the 
copyright symbol, etc., you can find them in the Character Map. Click the Start Button, Programs, 
Accessories, System Tools, then select 
Character Map. You'll be presented with a screen that has lots of different symbols. When you click a 
symbol, it gives you an enlarged preview of it. Select the Font you wish to view from the drop down Font 
list. Be sure to scroll down to see all of the available symbols for each font. 
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To actually select the symbol: 
1. Click the symbol you want.  
2. Click the Select button, then the Copy button.  
 
This will copy your symbol onto the clipboard where you can then paste it into any program that let's you 
insert text. 

Using the Alt Key to Open Menu Items 
In many programs certain letters in the toolbar words are underlined. These are keyboard short cuts using the 
Alt key. For Instance, if the word Edit in the toolbar has a line under the letter E, you can hold down Alt+E 
to open the Edit menu. Once inside the menu, you can use the keyboard to select any of the features listed by 
clicking the underlined letter of the appropriate menu choice. 

Launching Multiple Programs  
When you are working on your computer, you may need to launch multiple programs. Normally, you click 
the Start button, Programs, then select the program you want to run. Once that one starts, you go back 
through and repeat the process for the next program. There is a better way. Next time you need to launch 
more than one program from your Programs menu, hold down your Shift key while you click the program's 
icon. The application will launch, but you won't lose the Programs menu and have to start all over. 

The Difference Between Save and Save As  
When you use the Save command, you save your work under it's current file name. If you've never saved 
whatever it is you're working on before, then you'll get an opportunity to name it. 
 
When you use Save As, you get a chance to save what you're working on as a new file. Let's say you're 
working on a word processing document. It's a new document and you decide to save it. A box comes up that 
lets you give it a name. Now, let's say you add something to it. If you use the Save command again, it simply 
saves it with no questions asked under the 
existing file name. 
 
Now let's say you make a modification to the file, but you want to keep the original version as well. This is 
where you use Save As. When you use the Save As command, it allows you to save your current file as a 
new file with a new name. Now when you go to open your files, you'll find you have both the original 
version and the new, Saved As version. 

Opening the Shortcut Menu 
Normally, you right-click to bring up shortcut menus. Another way to open shortcut menus is to press Shift + 
F10. This will bring up the same menu you'd ordinarily get by right-clicking. With both the regular and 
shortcut menus, you can navigate up and down the menu with the Up and Down Arrow keys on your 
keyboard. 
 
Opening the Start Menu 
You can use the keyboard to open the Start button menu. Press Ctrl + Esc. You can then use Up and Down 
Arrow keys on your keyboard to navigate up and down, and the right arrow key to open sub menus in the list. 

Changing Your Desktop Wallpaper 
Right-click an area on your desktop and choose Properties. On the Background tab you'll find a list of images 
to use for wallpaper. Click the background you want from the list and it will appear in the preview screen. 
You can choose to Center, Tile, or Stretch the image to fit the screen. 
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You can also use any image on your computer as wallpaper. Click the Browse button and it will bring up 
the Browse File box where you can use anything you see, or you can navigate to any folder such as My 
Documents and select a photo. Click Apply if you want to see how it looks before you close the dialog box, 
then click OK if you want to keep your choice. 

The Difference Between Save and Save As  
When you use the Save command, you save your work under it's current file name. If you've never saved the 
document before, then you'll get an opportunity to name it. 
 
When you use Save As, you get a chance to save what you're working on as a new file. You're working on a 
word processing document. It's a new document and you decide to save it. A box comes up that lets you give 
it a name and save it. Then you add something to your document. If you use the Save command again, it 
simply saves it with no questions asked under the existing file name. 
 
Let's say you make a modification to the file, but you want to keep the original version as well. This is where 
you use Save As. When you use the Save As command, it allows you to save your current file as a new file 
with a new name. Now when you go to open your files, you'll find you have both the original version and the 
new, Saved As version. 

Using a Wireless Optical Mouse 
If you're using a wireless optical mouse then get a white or light-colored mouse pad. The mouse's infrared 
transmitter/receiver uses less power if it's reading a light-colored surface. This will make your batteries last 
longer. 

Shutting Down Multiple Programs 
If you need to shut down two or three open programs quickly, but leave the rest running, hold down the Ctrl 
key as you click their buttons on the taskbar. Then, right-click (still holding down the Ctrl key) one of those 
depressed buttons and select Close from the resulting menu. Note that you can also minimize, maximize, 
restore, cascade, or tile these windows using this same technique.  

Delete Shortcut Icons 
If you have a shortcut on your Desktop, Program file, or Taskbar that you want removed, just right-click and 
choose Delete. This works in other places, too. 
 
Auto Hide the Taskbar 
Right-click any blank area on your taskbar (your taskbar is what your Start button sits on) and select 
Properties from the menu that pops up. Select "Auto hide" from the resulting screen. Now, your taskbar will 
disappear when you move your mouse away from it and re-appear when you bring your mouse back. 

Deleting Shortcuts 
If you have a shortcut on your Desktop, Program file, or Taskbar that you want removed, just Right-click and 
choose "Delete". This works in other places, too, so give it a try. 
 
Autohide the Taskbar 
Right-click any blank area on your taskbar (your taskbar is what your Start button sits on) and select 
"Properties" from the menu that pops up. Select "Autohide" or "Auto-hide taskbar" from the resulting screen. 
Now, your taskbar will disappear when you move your mouse away from it and re-appear when you bring 
your mouse back. 
 
Rename a File 
There are at least three ways to rename a file: 
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1. Click the file name once to select it, click a second time to make it available to change, then type in the 
new file name. 
2. Right click the file and choose Rename. This will select the file name allowing you to type in a new one. 
3. Hold down the Alt key and double-click the file to open the Properties box. Type the new name in the 
name box. 

Print a Recently Used Document 
If you need to print a recently used document, don't waste time opening up the application you created it in. 
For a faster way, click the Start button, then Documents, then right-click the document you want and select 
"Print" from the resulting menu. The document's application will run, open the document, then print it for 
you. All automatically. 
 
Hide All Open Windows 
If you want to clear your screen of all the windows you have up (without closing the programs) so you can 
access your desktop, hold down the Window key + D. To bring it all back, Win Key + D again. 
 
Disable Autorun When Loading a CD 
If you want to load a CD but don't want it to autorun, hold down the Shift key when you insert the CD.  

Switching Between Open Programs 
An easy way to switch between programs you have open is to press ALT + TAB on the keyboard. A small 
box will pop up with icons for all the currently open programs. Hold down ALT, then press TAB until the 
window you're looking for is selected. As you tab, the title bar information is displayed below the icons. 
Hold down the ALT & SHIFT keys while pressing TAB to go backwards through the list. 
 
Open Print Window 
In almost all programs, Ctrl+P will open the print dialog box so that you can make selections to print a 
document. 
 
Find Where a File is Located 
If you need to find the path of a file on your hard drive, click Start / Run and then drag and drop any file to 
the Open bar and the path of that file will appear. 
 
Tile Your Windows 
If you would like to see two or more programs or windows open side by side at the same time: 
 
1. Minimize all but the windows you want open. 
2. Right-click a blank area of the toolbar and select either "Tile Windows Vertically" or "Tile Windows 
Horizontally." 
 
Now you have side by side or stacked windows evenly spaced on your screen. From there you can easily 
drag and drop or copy and paste. Maximize each window to go back to full screen. 
 
Using Print Screen 
The function of the PrtScrn key is to make a "snapshot" of your screen which you can then paste into an 
image program or Word and crop, etc. To capture the whole screen, press the Print Screen (Prt Sc) button on 
your keyboard. Then, open your imaging software or Word and select the Paste command (Ctrl+V). This 
should paste an image of your computer screen into the document you're working on. With Word 2000 and 
newer, you might need to have the program open before your press PrtScrn for the screenshot to go to the 
clipboard. If you would like to capture only the current window, hold down the ALT key while you press the 
Print Screen button. 
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Clean Up Your Taskbar 
If you work with a number of documents open at once in Office XP programs, your taskbar can become 
cluttered, displaying an icon for each document. To unclutter your taskbar, change your settings so that only 
a single icon is displayed on the Windows taskbar for each Office program. Go to Tools, Options, and click 
the View tab. Clear the Windows in Taskbar check box. You will need to do this for each program (Word, 
PowerPoint, etc.). You can then go to Window on the Menu Bar where you will see a list of open documents. 
Clicking on the documents toggles between them. 
 
Scientific Calculator 
There is an easy way to transform your computer Calculator into a scientific tool: Select Start, Programs, 
Accessories, Calculator; then select View, Scientific. Not sure what each of these new buttons does? All you 
have to do is ask. Right-click any button and click What's This? to display a description of that button with a 
keyboard equivalent at the bottom. 
 
If you want to print a list of these shortcuts, from the calculator window, select Help, Help Topics. On the 
Contents tab, select Use Keyboard Equivalents Of Calculator Buttons. Inside the Calculator Help window, 
select Options, Print, Print The Selected Topic, and then click OK. Adjust any printer options, if necessary, 
then click Print. 
 
Protecting Floppy Disks 
If you have a floppy disk with information that you don't want to overwrite or delete, there is a way to protect 
it. Floppies can be write protected by sliding a little tab so that it exposes a small hole in the upper right-hand 
corner of the disk (the slider is on the back side of the disk). If the hole is open, the disk can't be written to. If 
the hole is closed, it can. Just slide the tab to your preference. Some disks, especially the kind you get from a 
software company, may be read-only. 

Moving To the Beginning or End of a Document 
When you are in a large folder, on a long page in a document, or on the Internet, there is a way to go quickly 
to the beginning or the end. To go to the beginning, press Ctrl + Home. To go to the end, press Ctrl + End. 

Copying Files From a CD to Your Computer 
When you copy files from a CD to a computer, the files copy as Read Only. To work with the files, you will 
need to change the Read Only attribute. To do this, right-click the file (after you have copied it to your hard 
drive) and select Properties from the resulting menu. Next, uncheck the Read Only checkbox on the lower 
part of the Properties screen. Click OK. 

If you have several files that are all read-only, you can change them all at once. Select all of them using the 
Ctrl key, then right-click any selected file and follow the above steps. 

Edit a Screen Shot with Photo Editor 
*First, capture your screen shot by pressing the PrintScreen button. To capture the active window only, press 
Alt + PrintScreen.  
*On your Windows desktop, click the Start button, point to Programs, point to Microsoft Office Tools, and 
then click Microsoft Photo Editor.  
*On the Edit menu, click Paste as New Image.  
*To select only a portion of your screen shot (the portion you want to copy to your Office document), click 
Select on the Standard toolbar, and then drag your mouse pointer over the area you want to select.  
*On the Edit menu, click Copy.  
*Open the document you want to copy the selection into.  
*On the Edit menu, click Paste. 
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Deleting Files 
Next time you're 100% sure, without a doubt, for certain, that you want to delete a file, hold your Shift key 
down while you delete. The file will be deleted - skipping the Recycle Bin completely. This also works in 
Netscape Mail to bypass the Trash.  

Create a Desktop Shortcut 
To create a desktop shortcut for a program or file, first find the program or file by going to Start, Programs or 
opening your My Documents. Then right-click on the program or file, move your pointer over Send To and 
choose Desktop (create shortcut). You will now have an icon for it on your desktop. 

Right Click Without the Mouse 
There is a key on your keyboard that will right-click for you. It is the key to the left of the Ctrl key on the 
right side of your keyboard. Once you press it to bring up a menu of options, you can press the underlined 
letter of those options to choose them. Use the arrow keys to navigate through any lists. Press Enter to choose 
an item. To close the menu with the keyboard, press the Esc key. 

Quickly Open Print Dialog Box 
In almost all programs, Ctrl + P will open the print dialog box or start printing. This saves some steps. 

Printing a Recently Used Document 
If you need to print a recently used document, don't waste time opening up the application you created it in. 
Here's a faster way. Click the Start Button/Documents then right-click the document you want and select 
Print from the resulting menu. The document's application will run, open the document, then print it for you. 
All automatically.  

Hiding the Taskbar 
If you would you like to hide your taskbar and have it appear when you need it, right-click any blank area on 
your taskbar (your taskbar is what your Start button sits on) and select "Properties" from the menu that pops 
up. Select "Autohide" or "Auto-hide taskbar" from the resulting screen. Now, your taskbar will disappear 
when you move your mouse away from it and re-appear when you bring your mouse back.  

Organize Desktop Icons 
To organize your desktop icons, right-click the Desktop and select Arrange Icons. The sub-menu has icon 
arrangement options. You can arrange them by Name, Type, Size or Date. If your icons are scattered around 
your Desktop, Auto Arrange will line them up neatly on the left side.  
 
Changing Passwords 
When you are requested to change your password, you don't have to come up with a new one to remember. 
Just add a number. For example, if your password is tiger, change it to tiger2. That makes it easier to 
remember. 

Make New Folders 
To set up new folders within your My Documents folder, right-click the Start button, select Explore from the 
menu that pops up. Windows Explorer will open. You'll see the My Documents folder on the list to the left. 
Double-click it. In the right hand pane, right-click your mouse, select New and choose Folder. A new folder 
will pop up. Type in a name for it and you're all set. If you happen to click your mouse before the folder is 
named, you can right-click it and select Rename from the menu that pops up. You can also right click while 
inside any folder (or even on the desktop) and select New and Folder to create one. 

Quickly Repeat Last Action 
Here's a great keyboard shortcut for repetitive tasks. The F4 key is set to repeat the last action. If you press 
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the F4 key, the program will repeat the last action you completed. This works in Excel and Word. For 
example, say you've just inserted a row or column in Excel using the Insert menu. If you then press F4, you'll 
get a second row or column inserted without all the menu work. Repeatedly pressing the F4 key will continue 
to repeat the last action, allowing you to quickly insert multiple rows or columns. In Word, the F4 key will 
repeat text formatting, line spacing, text color changes, indenting, font changes, just typed phrases, drawing 
objects, etc. 

Quickly Minimize a Window 
To quickly minimize a Window, hold down the Alt key, press the Space Bar and type the letter N.  
 
Quickly Maximize a Window 
To quickly maximize a window, hold down the Alt key, press the Space Bar and type the letter X.  

Quickly Show Desktop 
To minimize all windows at once and show the Desktop, Press the Windows Key + M or click the Show 
Desktop button on the Quick Launch toolbar. 
 
Print Selection 
If you want to print only a couple of lines from something (a document, email, worksheet, etc…) Select the 
information to be printed. Then go to File, Print or (Ctrl + P). In the Print window under the Page Range 
section, choose Selection. Then press OK or Print.  

Use Microsoft Photo Editor to Edit a Screen Shot 
1. Capture your screen shot by pressing the PrintScrn button. (To capture the active window only, press Alt + 
PrintScrn.)  
2. On your Windows desktop, click the Start button, point to Programs, point to Microsoft Office Tools, and 
then click Microsoft Photo Editor.  
3. On the Edit menu, click Paste as New Image.  
4. To select only a portion of your screen shot (the portion you want to copy to your Office document), click 
Select on the Standard toolbar, and then drag your mouse pointer over the area you want to select.  
5. On the Edit menu, click Copy.  
6. Open the document you want to copy the selection into. On the Edit menu, click Paste.  
7. Work with it just like you would any other graphic. 

Safely Removing Hardware 
Even though USB devices are Plug & Play—that is, they're ready to go upon being plugged in—you 
shouldn't just unplug them. A USB port has current running through it, so the power jolt caused by 
unplugging a "hot" connection can corrupt data on a storage device, camera, or mp3 player. You can prevent 
such problems by clicking the "Safely Remove Hardware" button down in the system tray (near the clock). It 
looks like a rectangle with a green arrow. You'll be given a list of USB devices that are active. Select the one 
you want to remove and click. When the power shuts off Windows will tell you that it is safe to remove the 
device.  

Opening Multiple Programs 
Next time you need to launch more than one program from your Programs menu (Start/All Programs), hold 
down your SHIFT key while you click the program's icon. The application will launch, but you won't lose the 
Programs menu and have to start all over. 

Get Back a Lost Window 
If a window is outside of the visible desktop area and you can't seem to grab it with your pointer, click the 
button for it down in the taskbar to bring it into focus. Press Alt + Spacebar and it will bring up a System 
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menu (Restore, Move, Size, etc.) Usually this shows up in the upper left hand corner of a window, but on 
one that's offscreen it appears on your desktop as close to the window as it can. Press "M" for Move and use 
the arrow keys to bring it back into view. Once it's where you want it, press Enter or click your left mouse 
button. 

Adjusting the Sound on Your Computer 
If the sound on your computer is not loud enough, click the speaker sitting in your system tray on the right 
end of your Task Bar at the bottom of your screen. Drag the bar higher to make it louder. Click the Mute box 
if you want to temporarily mute your sound.  

Maximize Small Dialog Windows 
If you find the Open, Save As and other dialog windows too small when you open them to see everything,  
double-click the title bar of the open window. If it can be maximized, it will open full screen. Double-click 
the title bar again and the window will return to its original size. 

Using the PrtScrn Key 
The function of the Print Screen key is to make a "snapshot" of your screen which you can then paste into 
Word or an Image Editor to crop, size, etc. To capture the whole screen, press the Print Screen (it might say 
PrtScrn) key on your keyboard. Then, open the program you want to add the image to, and select the Paste 
command (or press Ctrl + V). If you would like to capture only the current window, press Alt + Print Screen. 

How Many Files in a Folder 
Do you ever wonder how many files are in a folder? With Windows XP you can right-click the folder and 
choose "Properties". Look where it says "Contains" to find out how many files and folders are in it. 
 
Close All Open Windows 
To close all open windows on your desktop, hold down the Windows key (the four curved boxes) and press 
the D key. They'll all minimize. To reverse that, hold down the Windows + D again. 

Change the Color Scheme of Windows XP 
The default color scheme of Windows XP is blue. If you get tired of blue and would like a different color, 
you can change it through the Display Properties. Right-click anywhere on your Desktop. Choose Properties. 
Click the Appearance tab at the top. In the box under Color Scheme, click the down arrow next to Default 
(blue). You can then choose between Olive Green and Silver. When you click on one of them, it will show 
you an example in the preview screen. After you choose a color, click either OK or Apply. Apply will apply 
the color and leave the Display Properties box open in case you wish to apply another color. OK will apply 
the color and close the box.  

Easily Maximize Windows 
In most Microsoft programs, double-clicking on the Title Bar (the one with the name of the program in it) 
will cause the window to toggle between taking up the full screen and part of the screen. 
 
Quickly Open the Start Menu 
If you want to open the Start Menu without your mouse, press Ctrl + Esc.  

Tab Between Open Programs 
If you have several windows open on your desktop, you can hold down the Alt key and press the Tab key to 
go between the open items. 
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Prevent CD From Autorunning 
If you don't want a CD to automatically play when you insert it into the drive, hold the Shift key down on the 
keyboard as you insert the disk. 

Remove Text Formatting 
If you have some text that is overly-formatted and you want to quickly change it to plain text, go to Start, 
Programs, Accessories, Notepad and paste the text into the Notepad window. All formatting will be removed. 
You can then copy the clean text and paste it into another program.  

The Difference Between Slash and Backslash 
The slash or commonly called forward slash is /, and backslash is \. The name tells in which direction the top 
of the slash points. Forward slashes tell your computer you're looking for something external to your system, 
like Web pages. Backslashes tell your computer you're looking for something inside your system, like a drive 
or a file. 

Check Recyle Bin 
If you aren't sure what you deleted, you can check the contents of the Recyle Bin on your desktop. Right-
click the Recycle Bin icon and choose Open to see the contents before you really delete it all. 
 
Renaming Shortcuts 
If you want to rename one of the shortcuts on your desktop, right-click the shortcut icon and select Rename 
from the resulting menu. The shortcut's name will be selected. Just type in the new name and press Enter.  

Open A Web Page From The Start Menu 
If you prefer, you can open a web page from the Windows Start menu. Let's say that you want to do a search 
on Google while you're working with your word processor. All you have to do is click Start, Run, type in 
www.google.com and press Enter. Your default browser will open at the Google Web site.  
 
Correcting Mistakes 
If you make a mistake, press Ctrl + Z. In most programs, that will undo whatever it was that you just did. 
Some programs only give you one or two of these "undo's." One way to make sure you can always go back is 
to save your file frequently - especially if you're about to make some big changes. Then if you really mess 
up, just close the file and DON'T SAVE IT. When you open it back up, it will be back to the way it was 
when you last saved.  

Right-click Using Your Keyboard 
Three keys to the right of your space bar is a key that looks like a menu with an arrow pointing to it. Space 
Bar, Alt Key, Windows Key and then the Menu Key. If you press the Menu Key, it will bring up the menu 
you normally bring up when you right-click. From there you can use the arrow keys to navigate through the 
pop-up menu and the Enter key to select your choice. To get out of the pop-up menu, press the Esc key. 
 
Another Way to Right-Click 
Holding down Shift + F10 does the same thing as a right mouse click. Then use the arrow keys to navigate to 
the item you want to choose from the menu. 

Quickly Print a Recently Used Document 
To quickly print a document that you were recently working on, click the Start button and choose 
Documents. Right-click the document you want and select Print from the menu. The document's application 
will run and open the document, and then print it for you. All automatically.  
 
If you don't see the document you want to print listed in the Documents menu, click the My Documents 
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folder you see at the very top of the Documents list (assuming the document you want to print is located in 
the My Documents folder). Then you can follow the steps above for right-click printing.  

Quickly Get to Your Desktop 
If you need a quick way to get back to your desktop after you've opened several windows, click the Show 
Desktop icon on your Taskbar at the bottom of your screen. With just one click, all of your open windows 
will be minimized. If you want to get all of your open windows back to their original size (restored), click on 
the Show Desktop icon again, and they will all be restored. 

Quick and Permanent Delete 
If you know you will never need an item again, you can hold Shift down as you press Delete on the 
keyboard. This will bypass the Recycle Bin or the Trash and permanently delete the file or message.  

File Sizes 
File sizes tend to be one of the more perplexing issues for beginning and intermediate computer users. Here 
is a breakdown of the various file size units you may encounter: 
 
Bit: The smallest unit in computing. It can have a value of 1 or 0.  
Byte: A (still small) unit of information made up of 8 bits.  
Kilobyte (KB): A unit of approximately 1000 bytes (1024 to be exact). Most download sites use kilobytes 
when they give file sizes. 
Megabyte (MB): 220 bytes = 1,048,576 bytes or 1,024 kilobytes. Sometimes used to mean 1 million bytes.  
Gigabyte (GB): Approximately 1 billion bytes (1024 MB). Most hard drive sizes are listed in gigabytes. 
 
Practical application: 
A 3 1/2" floppy disk holds 1.44 Megabytes (1,474 KB). 
A CD Rom holds 650-700 Megabytes. This would be around 450 of those 3.5 floppies. 
A 20 Gig hard drive will hold the same amount of info as 31 CD ROMs or 14,222 floppy disks. 

Sorting Files in the Open Dialog Box  
To sort files by Name, Size, Type or Modified Date, click on the column header at the top of each column. 
This also works in e-mail folders. 
 
Using the Character Map 
If you need a symbol or some other special character like the degree symbol, the small square checkbox, the 
copyright symbol, etc., you can find them in the Character Map. Click the Start Button, Programs, 
Accessories, System Tools, then select Character Map. You'll be presented with a screen that has lots of 
different symbols. When you click a symbol, it gives you an enlarged preview of it. Select the Font you wish 
to view from the drop down Font list. Be sure to scroll down to see all of the available symbols for each font. 
 
To actually select the symbol: 
1. Click the symbol you want.  
2. Click the Select button, then the Copy button.  
 
This will copy your symbol onto the clipboard where you can then paste it into any program that let's you 
insert text. 
 
Opening the Start Menu 
You can use the keyboard to open the Start button menu. Press Ctrl + Esc. You can then use Up and Down 
Arrow keys on your keyboard to navigate up and down, and the right arrow key to open sub menus in the list. 
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View Open Programs 
Say you have about four different programs running on your PC at the same time. You have your e-mail up 
and running, a Web browser window open, a Word document ready for review and you are working on a 
PowerPoint. For a quick way to view all of those programs and then pull up the one you want, press Alt + 
Tab and it will bring up all of the programs you have open. Continue to press the Tab key (keep holding the 
Alt key down) to scroll your way across the programs. Select the one you want and then release the ALT key 
to bring up the one you chose. To change programs again, repeat the process.  
 
Using the Menu Key 
On the right side of your keyboard between the Window Key and the Control Key is the Menu Key. When 
you press it, it opens up a drop down menu for whatever program you're in. The menu includes all the 
information you would see if you right-clicked, so I guess you could also call it the Right-Click Key.  
 
Delete Shortcut Icons 
If you have a shortcut icon on your Desktop or Taskbar that you want removed, just right-click on it and 
choose Delete. Some icons cannot be deleted from the desktop. You know that it is a shortcut icon if there is 
a little black arrow in the bottom left corner of the icon. 

Opening the Shortcut Menu 
Normally, you right-click to bring up shortcut menus. Another way to open shortcut menus is to press Shift + 
F10. This will bring up the same menu you'd ordinarily get by right-clicking. With both the regular and 
shortcut menus, you can navigate up and down the menu with the Up and Down Arrow keys on your 
keyboard. 

Change Name of Desktop Icon 
You can change the names of your desktop icons by using the F2 key on your keyboard. Select the icon you 
wish to change and press the F2 key. That will automatically change the text box under the icon so you can 
type in the new name. 
 
How to Display More Toolbars 
Choose Toolbars from the View menu. Select the toolbar you want to see (an active toolbar has a check next 
to its name). 

Restore Windows Down for Easier Viewing 
If you would like to view two or more windows at the same time, you can use the Restore Down button and 
size and arrange the windows for better viewing. Click the Restore Down button (the center button in the 
three in the top right corner of every window) in one of the windows. Then grab the top of the window with 
your mouse and move it wherever you want it to be on your screen. Put your pointer over the sides or corners 
of the window to size it. Arrange each window using the same technique until you have them arranged so 
that you can see them at the same time. Once you're finished, click the Restore Down button again and it will 
bring the window back to its maximum size. 

Using the Windows Calculator 
To access the built in calculator on your computer, go to Start, All Programs, Accessories and choose 
Calculator. A little calculator will pop up and you just use your mouse or your keyboard to punch in the 
numbers that you need. The plus (+), minus (-), multiply (x), division (/) and percent (%) signs are off to the 
right and it even has a fraction (1/x) and squareroot (sqrt) button in case you need those. There's also a 
Backspace button for when you accidentally type in the wrong thing. 
 
You can also go to the View menu and switch it over to a scientific calculator if you need a more advanced 
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calculator. That one comes with many other features as well, all located under the View menu. If you need 
any Help working the calculator, just go to the Help menu and check out the Help Topics.  

Working With Print Jobs 
Once you click on the final Print button that gets everything going, an icon appears in the System Tray at the 
right end of your taskbar (where the clock is). You can double click on that icon to see the progress of the 
print job. The icon will look something like a small printer. When you double click on it, you will see such 
headings as the name of the document you're printing, its status, the number of pages it is, the size of it and 
when it was submitted. You can also use this icon to cancel or pause a printing job if you need to do that. Just 
click on the Document menu and choose Pause, Cancel, Resume, etc. There's also a Help menu in case you 
run into any other problems. 

Delete Shortcut Icons on the Windows Desktop 
If you have a shortcut icon on your Desktop that you want removed, right-click on the icon and choose 
Delete. This works in other places, too. 

Choosing What to Print 
If you want to print only a couple of lines from a document, select the information to be printed. Then go to 
File, Print or press Ctrl + P. In the Print window under the Page Range section, choose Selection. Then press 
OK or Print.  

Move To Other Open Files in a Program 
To move between multiple open files in a program, hold down the Ctrl key and press the F6 function key. 
What this will do is toggle between all open files within the program. While holding down the Ctrl key, you 
can continue to press the F6 key until you rotate to the file you need. 
 
Auto Arrange Icons on Desktop 
Right-click on your desktop and point to Arrange Icons By. In the pop-up menu, choose Auto Arrange. This 
will put your icons in order. To be able to click and drag your icons where you want to put them, deselect 
Auto Arrange. 
 
Quickly Maximize and Minimize Windows  
To maximize or minimize the size of any window, double-click the title bar. 

Click and Drag 
If you click on a file and begin to drag it to a new location and change your mind, press the Esc key without 
releasing the mouse button. This will cause the dragging to stop. This works in all programs in which 
dragging files or objects is an option.  

Take a Picture of Your Screen 
If you would like to put a screen shot of your computer desktop in a PowerPoint presentation or Word 
document, there is an easy way to do it. Press the PrintScrn key on your keyboard to copy the entire screen. 
Then open PowerPoint or Word and press Ctrl+V to paste the image on the slide or page. To take a picture of 
just the top window open on your screen (such as an open dialog box), hold the Alt key while pressing the 
PrintScrn key. 

Closing Programs Shortcut 
To close the program you are working in without touching the mouse, the keyboard combination Alt + F4 
will close your application. This also works great for closing pop up Internet windows. 
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Use the Control Key for Copying 
To copy a file without having to perform any additional work, press and hold the Ctrl key while dragging the 
object to its destination. Windows will automatically make a copy of the file. This also works with drawing 
objects, selected text, graphics, etc. 

Keyboard Shortcuts 
Keyboard shortcuts can make your life easier! These are the basic shortcuts that everyone should know and 
use. Start your new year out right! 
 
Ctrl + Z: Undo (your best friend!) 
Ctrl + A: Select All 
Ctrl + C: Copy 
Ctrl + X: Cut 
Ctrl + V: Paste 
 
Keyboard Shortcuts Using the Windows Key 

 + E : Opens Windows Explorer 
 + M: Minimize all Windows 

Shift +  + M: Maximize all Windows (after minimizing) 

Zoom In and Out of Documents  
If you have a mouse with a wheel, press and hold the Ctrl key and scroll the wheel up to zoom in your 
document. Press and hold the Ctrl key and scroll the wheel down to zoom out. If you don't hold the Ctrl key 
down, the wheel will scroll between pages in a document and slides in a presentation. 

Uses for the F4 Function Key 
There are several uses for the F4 function located on your keyboard. First of all, you can use it to close any 
open applications. Make sure the program you want to close is selected, press Alt + F4 and that window will 
automatically close. If you're using one single application that has many different documents within it, press 
Ctrl + F4 and just that one window will close instead of the whole program. You can also use F4 to shut 
down your computer. Make sure all of your programs are closed and then press Alt + F4. That will bring up 
the "Turn off computer" dialog box and then you can proceed with the normal shut down. Pressing Alt + F4 
is the same as Start, Turn off computer. 

Organize With Notepad 
You can make a daily log with notepad.  
 
1. Open Notepad by going to Start, Programs, Accessories, Notepad.  
2. Type .LOG (in all caps) as the first line of the file, then Enter. Then save this file and close it. You could 
save it as My Log.txt, for instance. If you save it to your Desktop, you will have quick access to it throughout 
the day. 
3. Now, navigate to where you saved the file and double click it. Notepad appends the current date and time 
to the end of the file and places the cursor on the next line.  
4. Go ahead and type your notes. When you're finished, save the file again and close it.  
 
Each time you open the file, Notepad will repeat the process. So, each time, the new date and time will show 
up at the end of the file and it will place the cursor below it. You can then just type what you need to and 
save it all over again.  

Scientific Calculator 
To have use of a scientific calculator, select Start, Programs, Accessories, Calculator; then select View, 
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Scientific. To see what a button does, right-click on it and choose What's This? to display a description 
with a keyboard shortcut. To print a list of these shortcuts, select Help, Help Topics. On the Contents tab, 
select Calculator, then Using Keyboard Equivalents Of Calculator Buttons. Select Options, Print, Print The 
Selected Topic, click OK, then click Print. 
 
Resizing Graphics 
To resize a graphic and keep the same proportions, hold the Shift key while dragging on the resize handles. 
This will prevent the distortion of the picture. 

Renaming Photos  
When you import photos from your camera to your computer, pictures are all assigned a number. If you want 
to rename the picture, you have to do each one. There is a way that you can put a batch name on each image 
within a folder.  
 
1. Open the picture folder, then select View, Thumbnails.  
2. Select all pictures (Control-A or click the last picture in the folder, hold down the Shift key, and click the 
first picture to select them all). 3. Right-click the first photo.  
4. Select Rename from the drop-down menu and rename the file. Note: do not delete the .jpg file extension 
when you rename the file.  
5. Click the white space outside the photo.  
 
Watch as Windows applies the name with a sequential number to each picture in the folder.  

Using the End Key 
You've probably seen the End key on your keyboard, but have you ever used it? The End key can actually do 
different things, depending on the program you're using it with. Its main use though is to help you get from 
the top of a page to the bottom quickly. Press it once and you'll be taken to the bottom of any Web page, any 
document, any file, etc. Also, if you're working with some shorter text, the End key sometimes takes you the 
end of a line, which is also helpful and a much faster way of doing things. The End key is located in the little 
section of keys to the left of the numberpad on your keyboard.  
 
Select It All 
To select a complete document or page all at once instead of dragging your mouse from the bottom to the top 
of the page so you can copy and paste it, either go to the Edit menu and choose Select All, or press Ctrl + A 
on your keyboard. That will select the complete page of text, pictures, etc. Then you can just copy and paste 
the material wherever you want it. That is much faster than using your mouse! 
 
Using Find 
If you need to find a phrase on a Website, in a document, or even a file name on your computer, Ctrl + F will 
bring up a Find window in Windows XP and most programs. 

Control Key for Copying 
To copy just about anything - a file, a graphic, text, etc. without having to perform any additional work, press 
and hold the Ctrl key while dragging the object to its destination. Windows will automatically make a copy 
of the object. 
 
Remove USB Devices Safely 
I'm sure most of you have at least one USB device - digital camera, media player, external drive, etc. Even 
though USB devices are the plug and play type (that is, they're ready to go upon being plugged in), you 
shouldn't just unplug them. A USB port has current running through it, so the power jolt caused by 
unplugging a "hot" connection can corrupt data on a storage device, a camera, or an MP3 player. You can 
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prevent such problems by clicking the Safely Remove Hardware icon in the system tray at the bottom right 
of your screen (by the clock). It looks like a rectangle with a green arrow pointing down. You'll be given a 
list of USB devices that are active. Select the one you want to remove and click Stop. When the power shuts 
off Windows will tell you that it is safe to remove the device. Click Close and then remove it from your USB 
port. It's the best way to keep your "toys" safe!  

Save Your Work 
This may not seem like a tip that should have to be listed, but you would be surprised how many people still 
do not save their work periodically while working. They wait until they are finished. These same people end 
up occasionally losing hours of work because of this. If you get in the habit of saving when you have 
completed a section of your document, you won't lose as much if something happens to your computer in the 
middle of a project. 

Auto-hide the Taskbar Hidden Until Needed  
If you would like for the Taskbar to remain hidden until you need it by moving your mouse pointer to the 
bottom of the screen, right-click an empty area of the Taskbar and choose Properties. When the Taskbar and 
Start Menu Properties dialog box appears, select the Taskbar tab. Check Auto-hide the Taskbar. Click OK. 
Now, when you move your mouse pointer away from the bottom of the screen, the taskbar will disappear. 
Move your pointer to the bottom of the screen and your taskbar will reappear. 

Proper Removal of Flash Drives 
Many people are now using flash drives to store and transfer files. You may not know that there is a correct 
way to properly remove a flash drive from your computer's USB port. If you just pull it out when you are 
through, and if you keep doing it that way, you could end up ruining your flash drive. There are a couple of 
ways to remove it properly, but this is the easiest way. Click on the Safely Remove Hardware icon, located in 
the system tray at the bottom right of your computer screen. (It's a little green arrow with a little gray disk 
underneath it). Click Safely Remove USB Mass Storage Device. When the box pops up that says Safe to 
Remove Hardware, pull it out. This will keep your flash drive safe. 

Nudge Objects with Arrow Keys 
It is sometimes hard to move an object and place it right where you want it using your mouse. An easier way 
is to use the arrow keys to move it in the direction you want. Each press of the key will nudge the object 1/12 
of an inch in the direction that you choose. 

Restore a Picture to the Original 
If you insert a picture into a program and make changes to it, there is an easy way to return the picture to it's 
original state. Click on the picture. The Picture Toolbar should open. Click on the last button on the right, the 
Reset Picture button. This will return the picture to it's original size. If you don't see the Picture Toolbar, go 
to View, Toolbars, Picture. This works in most programs. 


